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1 About this document

1.1 Used symbols and signal words

Tab. 1.1: Warning symbols and signal words

Symbol indicating dangers to persons

NOTE Signal word for property damage
Indicates dangers that may result in property damage if the measures for dan-
ger avoidance are not followed.

Tab. 1.2: Other symbols

Symbol for tips
Text passages with this symbol provide you with further information.

Symbols for action steps
Text passages with this symbol instruct you to perform actions.

Symbol for action results
Text passages with this symbol describe the result of the preceding action.

Tab. 1.3: Terms and abbreviations

BCL Bar code reader

CMOS Semiconductor process for implementing integrated circuits
(Complementary Metal-Oxide-Semiconductor)

DCR Image-based code reader
(Dual Code Reader)

DTM Software device manager
(Device Type Manager)

EMC Electromagnetic compatibility

EN European standard

FDT Software frame for management of device managers (DTM)
(Field Device Tool)

FE Functional earth

GUI Graphical user interface

HID Device class for input devices with which users directly interact
(Human Interface Device)

IO or I/O Input/Output

LED LED
(Light Emitting Diode)

PLC Programmable Logic Control
(corresponds to Programmable Logic Controller (PLC))



Safety

Leuze electronic DCR 85 6

2 Safety
This code reader was developed, manufactured and tested in accordance with the applicable safety stan-
dards. It corresponds to the state of the art.

2.1 Intended use
The DCR 85 code reader is designed as a stationary scanner with integrated decoder for all common 1D
and 2D codes used for automatic object detection.

Areas of application
The DCR 85 code reader is intended especially for the following areas of application:

• In automatic analyzers
• For space-critical code reading tasks
• For installation in a housing or beneath covers

CAUTION

Observe intended use!
The protection of personnel and the device cannot be guaranteed if the device is operated in a
manner not complying with its intended use.
Ä Only operate the device in accordance with its intended use.
Ä Leuze electronic GmbH + Co. KG is not liable for damages caused by improper use.
Ä Read these operating instructions before commissioning the device. Knowledge of the oper-

ating instructions is an element of proper use.

NOTICE

Comply with conditions and regulations!
Ä Observe the locally applicable legal regulations and the rules of the employer's liability insur-

ance association.

2.2 Foreseeable misuse
Any use other than that defined under "Intended use" or which goes beyond that use is considered im-
proper use.
In particular, use of the device is not permitted in the following cases:

• in rooms with explosive atmospheres
• in circuits which are relevant to safety
• for medical purposes

NOTICE

Do not modify or otherwise interfere with the device!
Ä Do not carry out modifications or otherwise interfere with the device. The device must not be

tampered with and must not be changed in any way.
Ä The device must not be opened. There are no user-serviceable parts inside.
Ä Repairs must only be performed by Leuze electronic GmbH + Co. KG.

2.3 Competent persons
Connection, mounting, commissioning and adjustment of the device must only be carried out by competent
persons.
Prerequisites for competent persons:

• They have a suitable technical education.
• They are familiar with the rules and regulations for occupational safety and safety at work.
• They are familiar with the technical description of the device.
• They have been instructed by the responsible person on the mounting and operation of the device.
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Certified electricians
Electrical work must be carried out by a certified electrician.
Due to their technical training, knowledge and experience as well as their familiarity with relevant standards
and regulations, certified electricians are able to perform work on electrical systems and independently de-
tect possible dangers.
In Germany, certified electricians must fulfill the requirements of accident-prevention regulations BGV A3
(e.g. electrician foreman). In other countries, there are respective regulations that must be observed.

2.4 Disclaimer
Leuze electronic GmbH + Co. KG is not liable in the following cases:

• The device is not being used properly.
• Reasonably foreseeable misuse is not taken into account.
• Mounting and electrical connection are not properly performed.
• Changes (e.g., constructional) are made to the device.
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3 Device description

3.1 Device overview

3.1.1 About the DCR 85 code reader
The code reader is based on a CMOS imager with integrated decoder for all of the most popular 1D and 2D
codes such as DataMatrix, Aztec, QR Code, 2/5 Interleaved, Code 39, Code 128, UPC/EAN etc.
The many possible configurations of the device allow it to be adapted to a multitude of reading tasks. Due
to the small dimensions of the unit and the large reading field, the scan engine can also be used in highly
constrained spaces.
Information on technical data and characteristics: see chapter 11 "Technical data".

3.1.2 Stand-alone operation
The code reader is operated as a "stand-alone" single device. It is equipped with a 6-wire cable with open
ends for the electrical connection of the supply voltage, the interface, the trigger input and the switching
output.

3.2 Performance characteristics
• High-performance, miniature CMOS Imager with front beam exit
• Compact design for simple integration, even in constrained spaces
• Reading of extremely small high-density codes and recording of standard codes in a large reading area

using a special optical system
• Reading of shiny surfaces using a gloss reduction process
• Excellent decoding characteristics
• Clearly visible alignment LED
• RS 232 interface, one triggering input, one switching output
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3.3 Device construction

3

5

5

1

2

4

6

1 High resolution reading field lens
2 Wide-range reading field lens
3 LED indicators
4 Connection cable
5 LEDs for illumination (red light)
6 Alignment LEDs (blue light)

Fig. 3.1: Device construction of the DCR 85

3.4 Connection technology
• Connection cable, 6-wire with open cable end
• Cable (approx. 0.15 m) with M12 connector, 8-pin

3.5 Display elements
Located on device top are two LEDs that indicates the readiness for operation and the read status.

Tab. 3.1: LED indicators

LED State Description

PWR ON (continuous light) Voltage supply OK

GOOD READ ON (continuous light) Reading successful
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4 Mounting
You can fasten the code reader at the M2.5 mounting threads.

4.1 Selecting a mounting location

NOTICE

The size of the code module influences the maximum reading distance and the width of the
reading field. Therefore, when selecting a mounting location and/or the code label, take into ac-
count the different reading characteristics of the scanner with various code modules.

NOTICE

Observe when choosing the mounting location!
Ä Maintaining the required environmental conditions (temperature, humidity).
Ä Possible soiling of the reading window due to liquids, abrasion by boxes, or packaging mate-

rial residues.
Ä Lowest possible chance of damage to the scanner by mechanical collision or jammed parts.
Ä Possible extraneous light influence (no direct sunlight).

In order to select the right mounting location, several factors must be considered:
• Size, orientation, and position tolerance of the bar codes or Data Matrix codes on the objects to be

scanned.
• The reading field of the code reader in relation to the code module width.
• The resulting minimum and maximum reading distance from the respective reading field (see chapter

11.2 "Reading fields").
• Alignment of the code reader for avoiding reflections.
• Distance between code reader and host system with respect to the interface.

The best read results are obtained when
• the reading distance lies in the middle area of the reading field.
• there is no direct sunlight and extraneous light is avoided.
• the bar code labels are of good print quality and have good contrast ratios.
• you do not use high-gloss labels.
• the bar code or the Data Matrix code is moved past the reading window with an angle of rotation of 10°

to 15°.
• the red light beam is narrowed down for its respective reading task in order to avoid reflections on shiny

components.

NOTICE

The front beam exit of the scan engine is almost vertical to the optics. The code label must be
rotated by > 10° to avoid a total reflection of the red light beam in the case of glossy labels.

α

β

γ

α Azimuth angle
β Angle of inclination
γ Angle of rotation

Recommended angle of rotation: γ > 10°

Fig. 4.1: Definition of the reading angles
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5 Electrical connection

CAUTION

Safety notices
Ä Before connecting the device, be sure that the supply voltage agrees with the value printed

on the name plate.
Ä Connection of the device and maintenance work while under voltage must only be carried

out by a qualified electrician.
Ä The power supply unit for the generation of the supply voltage for the code reader and the

corresponding connection units must have a secure electrical insulation according to
IEC 60742 (PELV). For UL applications: only for use in class 2 circuits according to NEC.

Ä If faults cannot be cleared, the device should be switched off and protected against acciden-
tal use.

5.1 Voltage supply
The code reader is designed for connection to a 5 V supply voltage.

• +5 V DC (red)
• GND (violet)

An adapter circuit board with spring terminals, Molex plug connector and 9-pin SUB-D socket is available
as an accessory (see chapter 12.2 "Accessories").

• With the adapter circuit board, the conductors of the connection cable can be contacted via the spring
terminals and connected to the PC via the 9-pin SUB-D socket with an RS 232 interconnection cable.

• With the adapter circuit board, the voltage supply of 10 … 30 V DC can be fed in via spring terminals
or, alternatively, 5 V DC can be fed in via a micro USB connector.

5.2 Pin assignment

Tab. 5.1: Cable with open wire ends

Wire Assignment Description

Red +5V DC Operating voltage 5V DC IN

Violet GND Operating voltage 0V DC / reference ground IN

Black SW OUT Switching output OUT

Orange SW IN Switching input IN

White RS 232 RxD RxD signal line of the RS 232 interface IN

Green RS 232 TxD TxD signal line of the RS 232 interface OUT

Fig. 5.1: Cable with M12 connector, 8-pin, A-coded

5.3 Switching input / switching output
The code reader is provided with a switching input and a switching output.

• The switching input is used to trigger code reading.
• The switching output signals successful code reading.
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5.3.1 Switching input
By means of the SW IN switching input connection, you can trigger a read process in the standard setting
(low = active) with the connection TRIGGER (orange) and GND (violet). We recommend wiring a 2.2 kΩ
pull-up resistor as defined cable termination.

+ 5 V DC

TRIGGER

GND

4.5 … 5.5 V DC 

GND

2.2 k

1

2

3

1 Red
2 Orange
3 Violet

Connection version NPN: standard setting (low = active)

Fig. 5.2: Switching input for connection variant NPN (standard setting)

5.3.2 Switching output
The NPN switching output connection between switching output (black) and GND (violet) switches if a code
is detected against GND.

+ 5 V DC

OUT

GND

GND

+ 5 … 30  V DC

max. 20 mA !

RL

4.5 … 5.5 V DC 
1

2

3

1 Red
2 Black
3 Violet

Fig. 5.3: Switching output

NOTICE

Maximum loading of the switching output
Ä Do not load the switching output of the code reader with more than 20 mA at +5 … 30 V DC!
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5.4 PC or terminal connection
Via the serial interface, you can configure the code reader by means of a PC or terminal. For this, you need
an RS 232 connection that establishes the RxD, TxD and GND connections between PC and code reader.
The RS 232 connection can be established in the following ways:

• Direct connection of the code reader connection wires to the PC or terminal via its own connector.
• Connection via an MA-CR adapter circuit board

To simplify the connection of the connection wires to the PC interface, an adapter circuit board (MA-
CR) is available for implementing individual wire contacting to SUB-D, 9-pin (see chapter 12.2 "Acces-
sories").

12

10 11
3

4

8

9

5 6 7

1 RS 232 connection
2 CR 50 or DCR 80 connection
3 CR 100, CR 55, DCR 85 connection
4 Molex Micro-Fit, 6-pin
5 USB connection
6 Connection to machine control, PLC, external voltage supply 5 VDC
7 External voltage supply 10 … 30 VDC
8 SWIN DIP switch (level for trigger button; 5 V if the scanner high switching input is active, GND if the low

input is active)
9 USB/PWR DIP switch (USB position if voltage is supplied via USB; PWR position if voltage is supplied

via (7))
10 Trigger button
11 Status LEDs

Fig. 5.4: Connection options for MA-CR adapter circuit board

5.5 Cable lengths and shielding
The maximum cable length is 3 m.
Should a cable extension be necessary, make certain that the cables of the RS 232 interface are shielded.
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6 Configuration and diagnostics software - Sensor Studio
The Sensor Studio configuration software provides a graphical user interface for the operation, configura-
tion and diagnosis of the device via the RS 232 interface.
A device that is not connected to the PC can be configured offline.
Configurations can be saved and reopened as projects for transferring back to the device at a later time.

NOTICE

Only use the Sensor Studio configuration software for products manufactured by Leuze elec-
tronic.
The Sensor Studio configuration software is offered in the following languages: German, Eng-
lish, French, Italian and Spanish.
The FDT frame application of the Sensor Studio supports all languages; all languages may not
be supported in the device DTM (Device Type Manager).

The Sensor Studio configuration software is designed according to the FDT/DTM concept:
• You make the individual configuration settings for the bar code reader in the Device Type Manager

(DTM).
• The individual DTM configurations of a project can be called up via the frame application of the Field

Device Tool (FDT).
• Communication DTM for code readers: LeCommInterface
• Device DTM for the DCR 85 code reader

Procedure for the installation of the software and hardware:
Ä Install the Sensor Studio configuration software on the PC.
Ä Install the communication and device DTM.

Communication and device DTM are included in the LeAnalysisCollectionSetup installation package.
Ä Create DCR 85-DTM in the project tree of the Sensor Studio FDT frame.
Ä Connect code reader to PC (see chapter 5.4 "PC or terminal connection").

6.1 System requirements
To use the Sensor Studio configuration software, you need a PC or laptop with the following specifications:

Tab. 6.1: System requirements for Sensor Studio installation

Operating system Windows XP or higher (32 bit, 64 bit)
Windows Vista
Windows 7
Windows 8

Computer Processor type: 1 GHz or higher
Serial COM interface
CD-ROM drive
Main memory (RAM): at least 64 MB
Keyboard and mouse or touchpad

Graphics card At least 1024 x 768 pixels

Required hard disk capacity for
Sensor Studio and communica-
tion DTM

35 MB

NOTICE

Administrator privileges on the PC are necessary for installing Sensor Studio.
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6.2 Installing Sensor Studio configuration software

NOTICE

The installation files of the Sensor Studio configuration software must be downloaded from the
Internet at www.leuze.com.
For subsequent updates, you can find the most recent version of the Sensor Studio installation
software on the Internet at www.leuze.com.

6.2.1 Downloading configuration software
Ä Call up the Leuze home page: www.leuze.com
Ä Enter the type designation or part number of the device as the search term.
Ä The configuration software can be found on the product page for the device under the Downloads tab.

6.2.2 Installing the Sensor Studio FDT frame

NOTICE

First install the software!
Ä Do not yet connect the device to the PC. First install the software.

NOTICE

If FDT frame software is already installed on your PC, you do not need the Sensor Studio instal-
lation.
You can install the communication DTM and the device DTM in the existing FDT frame. Com-
munication DTM and device DTM are included in the LeAnalysisCollectionSetup installation
package.

Ä Start the PC.
Ä Download the configuration software from the Internet to the PC (see chapter 6.2.1 "Downloading con-

figuration software"). 
Unpack the installation package.

Ä Start the SensorStudioSetup.exe file.
Ä Follow the instructions on the screen.

The Installation Wizard installs the software and places a shortcut on the desktop ( ).

6.2.3 Install the communication DTM and device DTM
Prerequisites:
ü An FDT frame is installed on the PC.
Ä Start the LeAnalysisCollection.exe file from the installation package and follow the instructions on the

screen.
The installation wizard installs communication DTM and device DTM for DCR 85.

6.2.4 Connecting device to PC
The device is connected to the PC via the RS 232 interface.

• You need an RS 232 connection that establishes the RxD, TxD and GND connections between PC and
device (see chapter 5.4 "PC or terminal connection").

• The 5 V DC voltage supply is to be fed in externally (see chapter 5.1 "Voltage supply").
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NOTICE

The MA-CR adapter circuit board with spring terminals and plug connector for connecting the
device, as well as 9-pin SUB-D socket for connecting an RS 232 interconnection cable, is avail-
able as an accessory. An RS 232 interconnection cable to the PC is also available as an acces-
sory (see chapter 12 "Order guide and accessories").
The adapter circuit board requires 10 V … 30 V DC as external voltage supply, which can be fed
in via spring terminals.

6.3 Starting the Sensor Studio configuration software
Prerequisites:

• The device has been mounted (see chapter 4 "Mounting") and connected (see chapter 5 "Electrical
connection") correctly.

• The device is connected to the PC via the RS 232 interface (see chapter 6.2.4 "Connecting device to
PC").

• The Sensor Studio configuration software is installed on the PC (see chapter 6.2 "Installing Sensor Stu-
dio configuration software").

Ä Start the Sensor Studio configuration software by double-clicking the Sensor Studio icon ( ).
The mode selection of the Project Wizard is displayed.

Ä Select the Device selection without communication connection (offline) configuration mode and
click on [Next].

The Project Wizard displays the device selection list of the configurable devices.

Fig. 6.1: Device selection for code reader CR 85

Ä Select DCR 85 in the device selection and click on [Next].
The device manager (DTM) of the connected DCR 85 starts with the offline view for the Sensor Studio
configuration project.
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Ä Establish the online connection to the connected DCR 85.
In the Sensor Studio FDT frame, click on the [Establish connection with device] button ( ).
In the Sensor Studio FDT frame, click on the [Upload parameters to device] button ( ).

The current configuration data is displayed in the device manager (DTM).

Fig. 6.2: Configuration project: Sensor Studio device manager (DTM) for DCR 85

Ä The menus of the Sensor Studio device manager (DTM) can be used to change or read out the config-
uration of the connected device.
The user interface of the Sensor Studio device manager (DTM) is largely self-explanatory.
The online help system provides information on the menu items and adjustment parameters. Select the
Help menu item in the menu [?] ( ).

Ä Transfer the modified configuration parameters to the device.
If a connection exists, click on the [Download parameters to device] button ( ) on the task bar.

6.4 Exiting Sensor Studio
After completing the configuration settings, close the Sensor Studio configuration software.
Ä Exit the program via File > Exit.
Ä Save the configuration settings as a configuration project on the PC.

You can open the configuration project again at later time via File > Open or with the Sensor Studio

Project Wizard ( ).

6.5 Configuration parameters
In this chapter, you will find information and explanations on the configuration parameters of the device
manager (DTM).

NOTICE

This chapter does not include a complete description of the Sensor Studio configuration soft-
ware.
Complete information on the FDT frame menu and on the functions in the device manager
(DTM) can be found in the online help system.

The device manager (DTM) of the Sensor Studio configuration software offers the following configuration
functions:

• General (Control)
• Decode (see chapter 6.5.2 "Decode tab")
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• Host Interface (see chapter 6.5.3 "Host interface tab")
• Diagnosis (see chapter 6.5.4 "Diagnosis / Terminal")

NOTICE

The online help system displays information on the menu items and configuration parameters
for each function. Select the Help menu item in the menu [?].

6.5.1 General tab

Fig. 6.3: General tab

Trigger duration
(Trigger Duration)

Set the time, for which a read cycle remains active after a trigger
event.
Example: trigger duration = 3000 ms means that the scanner tries to
decode a code for a maximum of three seconds after a trigger event.
The read cycle ends after successful decoding or after the time that
has been preset here has relapsed.

Reading fields
(Decode Area)

Selection of the reading field. The scan engine has two reading fields:
• High resolution reading field
• Wide-range reading field

Scan mode
(Continuous Action)

Selection of the reading behavior:
• Read when triggered
• Presentation mode
• Duration reading

LED illumination
(Illumination)

Set the illumination time of the LEDs after successful reading.

Target illumination
(Targeting)

Switch the blue alignment LEDs on and off.

Target illumination time setting
(Target Time before Decode)

Setting of the time until which reading takes place after a trigger event.
The blue alignment LEDs light up immediately when the trigger event
occurs.
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6.5.2 Decode tab

Fig. 6.4: Decode tab

Code table
(DECODE)

Here, the codes which are to be decoded are set. We recommend en-
abling only the code types which are to actually be read with the corre-
sponding element numbers. Codes which are not enabled are not de-
coded!

Properties
(SYMBOLOGIES)

Use the … button to the right of the given code to select the code-spe-
cific settings.
Alternatively, the property settings can be selected directly via the
navigation tree under the Decode button.
The properties can be individually set for each code type.

Fig. 6.5: Standard settings for the Properties window (SYMBOLOGY SETTINGS) – Decode tab
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6.5.3 Host interface tab

Fig. 6.6: Host interface tab

Select the desired baud rate, the stop bits, the data bits, the parity and various transmission modes here.
The desired acknowledgment settings are also to be set in this selection window.

6.5.4 Diagnosis / Terminal

Fig. 6.7: Terminal

The Terminal tab provides the following functions:
• Send online commands to the code reader for diagnostic purposes.
• Visualize the code reader output.

The contents of the terminal display can be printed out or saved in a file for subsequent offline evaluation.
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6.5.5 Diagnosis / Image Viewer

Fig. 6.8: Diagnosis / Image Viewer

You can use the Image Viewer to display the image captured in the reading field on the screen. This helps
you find the optimum position for reliable reading.
If both reading fields are activated (Decode Area Both Fields), the high-resolution reading field and the
far-range reading field are displayed in the GUI.
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7 Starting up the device - Configuration

7.1 Measures to be performed prior to the initial commissioning

NOTICE

Ä Please observe the notices for device arrangement, see chapter 4.1 "Selecting a mounting
location".

Ä If possible, always trigger the scanner with the aid of commands or an external signal trans-
mitter (photoelectric sensor).

Ä Before commissioning, familiarize yourself with the operation and configuration of the de-
vice(s).

Ä Before connecting the supply voltage, recheck all connections and ensure that they have
been properly made.

7.2 Starting the device

7.2.1 Interface
Proper function of the interface can be most easily tested in service operation using the serial interface with
the Sensor Studio configuration software and a notebook computer.

7.2.2 Online commands
Using the online commands, important device functions can be checked, e.g. reading activation.

7.2.3 Problems
If a problem occurs that cannot be rectified even after checking all electrical connections and settings on
the devices and on the host, contact your responsible Leuze electronic subsidiary or Leuze electronic cus-
tomer service, see chapter 10 "Service and support".

7.3 Setting the communication parameters
You have now commissioned the device. Usually, you will have to configure it before you can use it. Using
the configuration options offered in the Sensor Studio or by means of the device DTM, the device can be
individually configured according to your application. For information on the various configuration options,
see chapter 6 "Configuration and diagnostics software - Sensor Studio" or refer to the online help.
It is normally sufficient to set the code type and code length in accordance with the 1D or 2D codes that are
to be read in order to be able to operate the device.
The setting of code type and code length is usually accomplished by using the Sensor Studio configuration
software (see chapter 6 "Configuration and diagnostics software - Sensor Studio").
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8 Online commands

8.1 Overview of commands and parameters
Online commands can be used to send commands directly to the device for control and configuration. For
this, the device has to be connected to a computer (host) via the serial interface.
Using the online commands you can:

• query the device version.
• activate and deactivate code reading.
• perform a software reset.

Command syntax

<cmd-prefix><cmd-type><data-size>[<data>]<reserved><crc>

<cmd-prefix> <0xEE><0xEE><0xEE><0xEE>

<cmd-type> One ASCII character

<data-size> Byte value 0 … 240
Number of bytes in <data>

[<data>] Optional: command data (byte values) in range of 0 … 255

<reserved> One byte, always <0x00>

<crc> Two bytes crc16 check sum

Answer syntax

<start-tag><packet-type>[<packet-data>]<EOT>

<start-tag> <0x01>X<0x1E>ap/

<packet-type> One ASCII character

[<packet-data>] Optional: answer data

<EOT> One byte <EOT> (<0x04> hex.)
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8.2 General online commands

Software version number

Command <cmd-prefix>I<0x00><0x00><0x03><0x3C>

Description Requests device version information

Parameter None

Answer <start-tag>iVVVVWWWWXXXXSSSSSSSSSSAOODYYYYHHIIIIJJJJKKKKL-
LLL <TAB>Z…Z<EOT>

• i: "I" string output
• VVVV: application firmware version number
• WWWW:core application firmware version number
• XXXX: reserved
• A: current execution state:

"A": core is running
• OO: OEM identifier
• D: display type

"0": no display device
• YYYY: reserved
• HH: hardware version
• IIII: hardware type identifier (value in register 21B)
• JJJJ: boot application version
• KKKK: operating system kernel version
• LLLL: root file-system version
• <TAB>: ASCII TAB character
• Z…Z: OEM decoder version:

null-terminated string of printable ASCII characters
Example:
i10261026none0020366861A0600000080006001600660002 -> cd(14.2.0)

Software reset

Command <cmd-prefix>Z<0x01>1<0x00><0x1C><0x04>

Description Carries out a software reset. The device is restarted and reinitialized, leaving it
in the same state as when the supply voltage is switched on.

Parameter None

Acknowledgment <start-tag>d<EOT>
"d": done response

Start decoding

Command <cmd-prefix>P<0x0C>(35)7FFFFFFF<0x00><0x57><0x5F>
<cmd-prefix>$<0x01><0x03><0x00><0x1F><0x5C>

Description The command consists of two individual commands.
• The first command sets the decoder duration to infinity.
• The second command activates decoding.

Parameter None

Acknowledgment <start-tag>d<EOT>
"d": done response (twice)
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Stop decoding

Command <cmd-prefix>P<0x05>(35)0<0x00><0x65><0x5B>

Description The command sets the decoder duration to zero and stops decoding.

Parameter None

Acknowledgment <start-tag>d<EOT>
"d": done response

Start continuous decoding

Command <cmd-prefix>P<0x06>(C4)03<0x00><0x01><0x75>

Description The command activates duration decoding.
The read result is continuously output until it is terminated by a command.

Parameter None

Acknowledgment <start-tag>d<EOT>
"d": done response

End continuous decoding

Command <cmd-prefix>P<0x06>(C4)FF<0x00><0x1C><0x71>

Description The command ends duration decoding.

Parameter None

Acknowledgment <start-tag>d<EOT>
"d": done response

8.3 Text commands
Text commands are activated via the following start sequence: ;>PA1<CR>
With PA8<CR>, the input of text commands is ended.
Example:

Tab. 8.1: Activate decoding of Interleaved 2 of 5 codes with 10 (0x0A) characters

Command Description

;>PA1<CR> Activate text commands

P(6E)1<CR> Activate decoding of Interleaved 2 of 5 codes

P(C9)0A<CR> Code length: 10 (0x0A) characters

PA8<CR> Deactivate text commands

Command syntax

<Command-Type><Command-Data><CR>

<Command-
Type>

P The settings are stored in a register. The settings are lost when the device is
restarted.

C The settings are stored in a register. The settings remain stored when the device is
restarted.

<Command
Data>

See tables

<CR> Carriage return
ASCII control character 0x0D
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Command data
Format: (XXX)YYY

• XXX: register number in ASCII hex
• YYY: setting value in ASCII hex

Tab. 8.2: Decoding – Common properties

Parameter settings Command data

Common proper-
ties

Maximum labels to decode (34)1 … 10

Ignore duplicate codes (ms) (159)0 … 7FFFFFF

Tab. 8.3: Decoding – 1D codes

Code Parameter settings Command data

Code properties 1D barcode aggressiveness

Most aggressive (13)0

Less aggressive (13)1

Less aggressive (13)2

Interleaved 2 of 5 Settings of register C9 are bitwise OR-connected.
• The length (number of digits) is always even and can be represented by an inte-

ger value without using bit 0.
• Bit 0 is used to enable/disable Small Quiet Zone (SMZ)

Interleaved 2 of 5 Decoding

enable (6E)1

disable (6E)0

Interleaved 2 of 5 Length (C9)0 … 64

Interleaved 2 of 5 Small Quiet Zone (SMZ)

enable (C9)1

disable (C9)0

Interleaved 2 of 5 Checksum checking

disable (71)0

enable (71)1

Enable and strip from output (71)2

Code 32
Code 39

Decoding

disable (6B)0

enable Code 39 but not Code 32 (6B)1

enable Code 32 but not Code 39 (6B)2

enable Code 39 and Code 32 (6B)3

Code 39 Checksum checking

disable (70)0

enable (70)1

Enable and strip from output (70)3

Code 39 Full ASCII symbology

disable (49)0

enable (49)1
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Code Parameter settings Command data

Code 93 Decoding

disable (6C)0

enable (6C)1

Code UPC
Code EAN

UPC and EAN codes enabled

disable (6A)0

enable (6A)1

Code UPC Supplemental data output

disable (4E)0

enable (4E)1

Code 128 Decoding

enable (6D)1

disable (6D)0

Codabar Decoding

enable (6F)1

disable (6F)0

Codabar Checksum checking

disable (48)0

enable (48)1

Enable and strip from output (48)3

GS1 DataBar The settings of register 4C are bitwise OR-connected
• Example: Command (4C)06 enables GS1 DataBar Limited decoding and GS1

DataBar Expanded Stacked decoding
• Command (4C)00 disables all GS1 DataBar symbologies

GS1 DataBar Omnidirectional Decoding, Truncated Decoding

enable (4C)08

disable (4C)00

GS1 DataBar Limited decoding

enable (4C)04

disable (4C)00

GS1 DataBar Expanded decoding

enable (4C)01

disable (4C)00

GS1 DataBar Omnidirectional Stacked Decoding, Stacked Decoding

enable (4C)10

disable (4C)00

GS1 DataBar Expanded tacked decoding

enable (4C)02

disable (4C)00
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Code Parameter settings Command data

MSI Plessey The settings of register 4F are bitwise OR-connected
• Example: Command (4F)25 enables MSI Plessey decoding with Two Bytes Mod-

ulo 11/10 checksum and UK Plessey decoding
• Command (4F)00 disables all MSI Plessey decoding and the checksum settings

MSI Plessey Decoding

enable (4F)01

disable (4F)00

MSI Plessey Checksum method

Checksum checking disabled (4F)00

One Byte Modulo 10 (4F)02

Two Bytes Modulo 11/10 (4F)04

Two Bytes Modulo 10 (4F)06

One Byte Modulo 10 and strip from output (4F)09

Two Bytes Modulo 11/10 and strip from
output

(4F)0A

Two Bytes Modulo 10 and strip from out-
put

(4F)0C

MSI Plessey UK Plessey (original) decoding

enable (4F)20

disable (4F)00

Tab. 8.4: Decoding extras – 1D codes

Parameter settings Command data

Settings of register 24F are bitwise OR-connected.
Example: Command (24F)8435 enables the following options

• Send Code 39 start and stop delimiter
• Force output of all decoding data to upper case
• Remove UPC-A check digit
• Remove UPC-A number system digit
• Convert EAN-8 to EAN-13
• Remove GS1 DataBar “()” characters

Send Code 39 start and stop delimiters

enable (24F)0001

disable (24F)0000

Remove Codabar start and stop delimiters

enable (24F)0002

disable (24F)0000

Force all decoding data to upper case

enable (24F)0004

disable (24F)0000

Force all decoding data to lower case

enable (24F)0008

disable (24F)0000
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Parameter settings Command data

Remove UPC-A check digit

enable (24F)0010

disable (24F)0000

Remove UPC-A number system digit

enable (24F)0020

disable (24F)0000

Remove UPC-E check digit

enable (24F)0040

disable (24F)0000

Remove UPC-E number system digit

enable (24F)0080

disable (24F)0000

Remove EAN-13 check digit

enable (24F)0100

disable (24F)0000

Remove EAN-8 check digit

enable (24F)0200

disable (24F)0000

Convert EAN-8 to EAN-13

enable (24F)0400

disable (24F)0000

Convert UPC-A to EAN-13

enable (24F)0800

disable (24F)0000

Convert Bookland EAN-13 to ISBN

enable (24F)1000

disable (24F)0000

Convert Bookland EAN-13 to ISSN

enable (24F)2000

disable (24F)0000

Remove GS1 DataBar “()” characters

enable (24F)8000

disable (24F)0000



Online commands

Leuze electronic DCR 85 30

Tab. 8.5: Decoding – Stacked codes

Code Parameter settings Command data

PDF 417 Decoding

enable (29)1

disable (29)0

Micro PDF 417 decoding

enable (2A)1

disable (2A)0

Tab. 8.6: Decoding – 2D codes

Code Parameter settings Command data

Code properties Image transform

No transform (14)0

Mirror (14)1

DataMatrix Settings of register 19 are bitwise OR-connected. Example:
• Command (19)5 enables standard and mirror DataMatrix decoding and disables

inverse DataMatrix decoding.

DataMatrix Standard decoding

enable (19)1

disable (19)0

DataMatrix Inverse decoding

enable (19)2

disable (19)0

DataMatrix Mirror decoding

enable (19)4

disable (19)0

DataMatrix Rectangular symbology

enable (16)1

disable (16)0

Aztec Settings of register 50 are bitwise OR-connected. Example:
• Command (50)5 enables standard and mirror Aztec decoding and disables in-

verse Aztec decoding.

Aztec Standard decoding

enable (50)1

disable (50)0

Aztec Inverse decoding

enable (50)2

disable (50)0

Aztec Mirror decoding

enable (50)4

disable (50)0
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Code Parameter settings Command data

QR code Settings of register 2B are bitwise OR-connected. Example:
• Command (2B)11 enables standard and mirror QR Code decoding and disables

inverse, micro, and Model 1 QR Code decoding.

QR code Standard decoding

enable (2B)01

disable (50)00

QR code Inverse decoding

enable (2B)02

disable (2B)00

QR code Micro decoding

enable (2B)04

disable (2B)00

QR code Mirror decoding

enable (2B)10

disable (2B)00

QR code Model 1 decoding

enable (2B)20

disable (2B)00

Tab. 8.7: Output

Parameter settings Command data

Notification of read failure

enable (55)1

disable (55)0

Output result with AIM ID

AIM ID in prefix (ED)1

No AIM ID in prefix (ED)0
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Tab. 8.8: Control options

Option Parameter settings Command data

Trigger duration

Trigger duration [ms] (35)0 … 7FFFFFFF

Decode area

Read in both fields (39)3

Read in high-density field (39)5

Read in wide-angle field (39)6

Continuous action

idle (C4)FF

Read continuously in both fields (C4)03

Read continuously in high-density field (C4)05

Read continuously in wide-angle field (C4)06

Motion control (C4)F0

Illumination

Minimum illumination (04)0

Leave illumination during read (04)1

Targeting

enable (0F)1

disable (0F)0

Target time before decoding [ms] (33)0 … 7FFFFFFF

Beep volume

silent (26)00

low (26)21

medium (26)32

high (26)42

full (26)64
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Tab. 8.9: Host interface settings

Setting Parameter settings Command data

RS 232 Baud rate [BAUD]

9600 (1C)02580

19200 (1C)04B00

38400 (1C)09600

57600 (1C)0E100

115200 (1C)1C200

RS 232 Data length

7 bits (1E)7

8 bits (1E)8

RS 232 Parity

none (22)0

odd (22)1

even (22)2

RS 232 Stop bits

1 bit (1D)1

2 bits (1D)2

RS 232 Flow control

Disabled (1F)0

Hardware (1F)1

Handshake Acknowledgment expected

enable (42)1

disable (42)0

Acknowledgment time limit [ms] (37)0 … 7FFFFFFF
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9 Care, maintenance and disposal
Usually, the device does not require any maintenance by the operator.

9.1 Cleaning
Clean the glass window of the device with a soft cloth before mounting.

NOTICE

Do not use aggressive cleaning agents!
Ä Do not use aggressive cleaning agents such as thinner or acetone for cleaning the device.

9.2 Servicing
Repairs to the device must only be carried out by the manufacturer.
Ä For repairs, contact your responsible Leuze electronic subsidiary or Leuze electronic customer service

(see chapter 10 "Service and support").

9.3 Disposing
Ä For disposal observe the applicable national regulations regarding electronic components.
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10 Service and support

24-hour on-call service at:
+49 (0) 7021 573-0

Service hotline:
+49 (0) 7021 573-123
Monday to Friday 8.00 a.m. to 5.00 p.m. (UTC+1)

E-mail:
service.identify@leuze.de

Return address for repairs:
Service center
Leuze electronic GmbH + Co. KG
In der Braike 1
D-73277 Owen / Germany

10.1 What to do should servicing be required?

NOTICE

Please use this chapter as a master copy should servicing be required!
Ä Enter the contact information and fax the form together with your service order to the fax

number given below.

Customer data (please complete)

Device type:

Serial number:

Firmware:

Display messages:

Status of LEDs:

Error description:

Company:

Contact person/department:

Phone (direct dial):

Fax:

Street/No:

ZIP code/City:

Country:

Leuze Service fax number:
+49 (0) 7021 573-199
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11 Technical data

11.1 General specifications

Tab. 11.1: Optics

Optical system CMOS Imager, Rolling Shutter (1280 x 960)

Optical resolution High-resolution reading field 960 x 640
Wide-range reading field 960 x 640

Reading area 20 mm … 300 mm

Contrast 1D code: 25 %
2D code: 35 %

Resolution 1D code: m =0 .076 mm (3 mil), distance dependent
2D code: m = 0.127 mm (5 mil), distance dependent

Light sources
• Illumination
• Alignment LEDs (Aimer)

integrated LEDs
• visible red light
• visible blue light

Tab. 11.2: Code specifications

Code type: 1D Codabar, Code 11, Code 32 , Code 39, Code 93, Code 128, Inter-
leaved 2 of 5, GS1 DataBar (RSS), MSI Plessey, Pharmacode, UPC/EAN,
2 of 5 (IATA, Matrix, Hong Kong, Straight, NEC), Telepen

Code type: Stacked 1D PDF417, MicroPDF, GS1 Composite, Codablock F

Code type: 2D Data Matrix, Aztec Code, QR Code, Micro QR, MaxiCode

Postal Codes Australian Post, Intelligent Mail, Japan Post, KIX Code, Korea Post, Planet,
Postnet, UK Royal Mail, UPU ID Tags

Tab. 11.3: Interfaces

Interface type RS 232

Baud rate 9600 … 115200 baud, configurable

Data formats configurable

Trigger • Switching input
• active: 0 V
• inactive: +5 V or not connected

• Presentation Mode (Motion Control)

Switching output NPN transistor output, max. 20 mA, Good Read

Tab. 11.4: Electrical equipment

Operating voltage 4.5 … 5.5 V DC

Current consumption Duration reading: typ. 350 mA
Inactive illumination: typ. 75 mA

LEDs 1 device status
1 read status
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Tab. 11.5: Mechanical data

Degree of protection IP 54

Connection type fixed cable, 2 m long, 6 x 0.081 mm² (AWG 28)

Weight 70 g (without cable)

Dimensions (H x W x D) 25 x 39 x 55.5 mm

Fastening 3x M2.5 bore holes, 5 mm deep

Housing Metal, die-cast aluminum

Tab. 11.6: Environmental data

Ambient temp. (operation/storage) 0 °C … +50 °C/-20 °C … +60 °C

Air humidity 10 % … 90 % rel. humidity, non-condensing

Electromagnetic compatibility EN 55022:2006 Class B
IEC 62471:2006

Conformity CE, FCC

Ambient light max. 100000 Lux

11.2 Reading fields

NOTICE

Please note that the actual reading fields are also influenced by factors such as labeling mate-
rial, printing quality, scanning angle, printing contrast etc., and may thus deviate from the read-
ing fields specified here. The origin of the read distance always refers to the front edge of the
housing of the beam exit.
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1

2

3

4

3

4

1 Reading fields – side view
2 Reading fields – top view
3 High resolution reading field
4 Wide-range reading field

Fig. 11.1: Reading fields

Tab. 11.7: Reading fields

Code type Resolution Typical reading distance [mm]

Code 39 0.076 mm (3 mil)
80 102

Code 39 0.190 mm (7.5 mil)
33 182

GS1 Data bar 0.267 mm (10.5 mil)
20 220

UPC Data bar 0.330 mm (13 mil)
28 280

Data Matrix 0.127 mm (5 mil)
43 115

Data Matrix 0.160 mm (6.3 mil)
33 150

Data Matrix 0.254 mm (10 mil)
20 180

Data Matrix 0.528 mm (20.8 mil)
28 343



Technical data

Leuze electronic DCR 85 39

11.3 Dimensioned drawings

all dimensions in mm
A 4 integrated LEDs for illumination (red light)
B1 High resolution reading field lens
B2 Wide-range reading field lens
C 2 integrated target LEDs (blue light)
D Status LEDs

Fig. 11.2: DCR 85 dimensioned drawing
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12 Order guide and accessories

12.1 Type overview

Tab. 12.1: Part numbers

Part no. Part designation Description

50131458 DCR85M2/R2 CMOS Imager code reader for 1D- and 2D-codes,
RS 232 interface, permanently attached connection cable,
2 m long

50131581 DCR85M2/R2-150-M12.8 CMOS Imager code reader for 1D- and 2D-codes,
RS 232 interface, approx. 0.15 m cable with M12 connec-
tor (8-pin)

12.2 Accessories

Tab. 12.2: Accessories

Part no. Part designation Description

50128204 MA-CR Adapter circuit board for contacting the 12-pin plug
connector and conversion to SUB-D, 9-pin

50113396 KB DSub-9P-3000 RS 232 interconnection cable, cable length 3 m

50104591 K-D M12A-8P-2m-PUR M12 connection cable, axial 8-pin socket, cable
length 2 m, shielded

Sensor Studio configuration software
Download at www.leuze.com
see chapter 6.2.1 "Downloading configuration soft-
ware"

Sensor Studio designed according to the FDT/DTM
concept. Contains: communication DTM and device
DTM
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13 EC Declaration of Conformity
The scan engines of the DCR 85 series have been developed and manufactured in accordance with the
applicable European standards and directives.
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14 Appendix

14.1 Bar code samples

Module 0.3

Fig. 14.1: Code type 01: Interleaved 2 of 5

Module 0.3

Fig. 14.2: Code type 02: Code 39

Module 0.3

Fig. 14.3: Code type 11: Codabar

Module 0.3

Fig. 14.4: Code 128

Module 0.3

Fig. 14.5: Code type 08: EAN 128

SC 2

Fig. 14.6: Code type 06: UPC-A
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SC 3

Fig. 14.7: Code type 07: EAN 8

Fig. 14.8: Example codes

14.2 Configuration via configuration codes
The device can also be configured using configuration codes. The device parameters in the device are set
and permanently saved after reading this code.
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DCR 80 Configuration Guide

Fig. 14.9: DCR 80 Configuration Guide
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DCR 80 Configuration Guide

Fig. 14.10: DCR 80 Configuration Guide
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DCR 80 Configuration Guide

Fig. 14.11: DCR 80 Configuration Guide
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DCR 80 Configuration Guide

Fig. 14.12: DCR 80 Configuration Guide
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DCR 80 Configuration Guide

Fig. 14.13: DCR 80 Configuration Guide
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DCR 80 Configuration Guide

Fig. 14.14: DCR 80 Configuration Guide
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DCR 80 Configuration Guide

Fig. 14.15: DCR 80 Configuration Guide
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DCR 80 Configuration Guide

Fig. 14.16: DCR 80 Configuration Guide
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DCR 80 Configuration Guide

Fig. 14.17: DCR 80 Configuration Guide
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DCR 80 Configuration Guide

Fig. 14.18: DCR 80 Configuration Guide
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